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Chapter 547 

One-Way Analysis of 
Variance F-Tests 
Introduction 
A common task in research is to compare the averages of two or more populations (groups). We might want to 
compare the income level of two regions, the nitrogen content of three lakes, or the effectiveness of four drugs. 
The one-way analysis of variance compares the means of two or more groups to determine if at least one mean is 
different from the others. The F test is used to determine statistical significance. F tests are non-directional in that 
the null hypothesis specifies that all means are equal and the alternative hypothesis simply states that at least one 
mean is different.  

The methods described here are usually applied to a one-way experimental design. This design is an extension of 
the design used for the two-sample t test. Instead of two groups, there are three or more groups.  

Assumptions 
Using the F test requires certain assumptions. One reason for the popularity of the F test is its robustness in the 
face of assumption violation. However, if an assumption is not even approximately met, the significance levels 
and the power of the F test are invalidated. Unfortunately, in practice it often happens that several assumptions are 
not met. This makes matters even worse. Hence, steps should be taken to check the assumptions before important 
decisions are made. 

The assumptions of the one-way analysis of variance are: 

1. The data are continuous (not discrete). 

2. The data follow the normal probability distribution. Each group is normally distributed about the group 
mean. 

3. The variances within the groups are equal. 

4. The groups are independent. There is no relationship among the individuals in one group as compared to 
another. 

5. Each group is a simple random sample from its population. Each individual in the population has an equal 
probability of being selected in the sample. 
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Technical Details for the One-Way ANOVA 
Suppose G groups each have a normal distribution and equal means(𝜇𝜇1 = 𝜇𝜇2 = ⋯ = 𝜇𝜇𝐺𝐺). Let 𝑁𝑁1 = 𝑁𝑁2 = ⋯ =
𝑁𝑁𝐺𝐺  denote the number of subjects in each group and let N denote the total sample size of all groups. Let 𝜇̅𝜇𝑤𝑤 denote 
the weighted mean of all groups. That is 

𝜇̅𝜇𝑤𝑤 = ��
𝑁𝑁𝑖𝑖
𝑁𝑁
�

𝐺𝐺

𝑖𝑖=1

𝜇𝜇𝑖𝑖 

Let 𝜎𝜎 denote the common standard deviation of all groups.  

Given the above terminology, the ratio of the mean square between groups to the mean square within groups 
follows a central F distribution with two parameters matching the degrees of freedom of the numerator mean 
square and the denominator mean square. When the null hypothesis of mean equality is rejected, the above ratio 
has a noncentral F distribution which also depends on the noncentrality parameter, 𝜆𝜆. This parameter is calculated 
as 

𝜆𝜆 = 𝑁𝑁
𝜎𝜎𝑚𝑚2

𝜎𝜎2
 

where 

𝜎𝜎𝑚𝑚2 = ∑ �𝑁𝑁𝑖𝑖
𝑁𝑁
�𝐺𝐺

𝑖𝑖=1 (𝜇𝜇𝑖𝑖 − 𝜇̅𝜇𝑤𝑤)2 

Some authors use the symbol 𝜙𝜙 for the noncentrality parameter. The relationship between the two noncentrality 
parameters is 

𝜙𝜙 = �𝜆𝜆
𝐺𝐺

 

The process of planning an experiment should include the following steps: 

1. Determine an estimate of the within group standard deviation, 𝜎𝜎. This may be done from prior studies, 
from experimentation with the Standard Deviation Estimation module, from pilot studies, or from crude 
estimates based on the range of the data. See the chapter on estimating the standard deviation for more 
details. 

2. Determine a set of means that represent the group differences that you want to detect. 

3. Determine the appropriate group sample sizes that will ensure desired levels of 𝛼𝛼 and 𝛽𝛽. Although it is 
tempting to set all group sample sizes equal, it is easy to show that putting more subjects in some groups 
than in others may have better power than keeping group sizes equal (see Example 4). 

Power Calculations for One-Way ANOVA 
The calculation of the power of a particular test proceeds as follows: 

1. Determine the critical value, 𝐹𝐹𝐺𝐺−1,𝑁𝑁−𝐺𝐺,𝛼𝛼 where 𝛼𝛼 is the probability of a type-I error and G and N are 
defined above. Note that this is a two-tailed test as no direction is assigned in the alternative hypothesis. 

2. From a hypothesized set of 𝜇𝜇𝑖𝑖′𝑠𝑠, calculate the noncentrality parameter 𝜆𝜆 based on the values of  
𝑁𝑁,𝐺𝐺,𝜎𝜎𝑚𝑚, and 𝜎𝜎.  

3. Compute the power as the probability of being greater than 𝐹𝐹𝐺𝐺−1,𝑁𝑁−𝐺𝐺,𝛼𝛼 on a noncentral-F distribution with 
noncentrality parameter 𝜆𝜆. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are Power, Sample Size, and Effect Size. Under most situations, you will select either Power for a power 
analysis or Sample Size for a sample size determination. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
equal means when in fact the means are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered. 

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal 
means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size and Group Allocation  

G (Number of Groups) 
This is the number of groups (arms) whose means are being compared. The number of items used in the Group 
Allocation boxes is controlled by this number. 

This value must be an integer greater than or equal to two. 
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Group Allocation Input Type (when Solve For = Power or Effect Size) 
Specify how you want to enter the information about how the subjects are allocated to each of the G groups. 

Possible options are: 

• Equal (N1 = N2 = ... = NG) 
The sample size of all groups is Ni. Enter one or more values for the common group sample size. 

• Enter group multipliers 
Enter a list of group multipliers (r1, r2, ..., rG) and one or more values of Ni. The individual group sample 
sizes are found by multiplying the multipliers by Ni. For example, N1 = r1 x Ni. 

• Enter N1, N2, ..., NG 
Enter a list of group sample sizes, one for each group. 

• Enter columns of Ni's 
Select one or more columns of the spreadsheet that each contain a set of group sample sizes going down the 
column. Each column is analyzed separately. 

Ni (Subjects Per Group) 
Enter Ni, the number of subjects in each group. The total sample size, N, is equal to Ni x G. 

You can specify a single value or a list. 

Single Value 
Enter a value for the individual sample size of all groups. If you enter '10' here and there are five groups, then 
each group will be assigned 10 subjects and the total sample size will be 50. 

List of Values 
A separate power analysis is calculated for each value of Ni in the list. All analyses assume that the common, 
group sample size is Ni. 

Range of Ni 
Ni > 1 

Group Multipliers (r1, r2, ..., rG) 
Enter a set of G multipliers, one for each group.  

The individual group sample sizes is computed as Ng = ceiling[rg x Ni], where ceiling[y] is the first integer 
greater than or equal to y. For example, the multipliers {1, 1, 2, 2.95} and base Ni of 10 would result in the 
sample sizes {10, 10, 20, 30}. 

Incomplete List 
If the number of items in the list is less than G, the missing multipliers are set equal to the last entry in the list. 

Range 
The items in the list must be positive. The resulting sample sizes must be at least 1. 
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Ni (Base Subjects Per Group) 
Enter Ni, the base sample size of each group. The number of subjects in the group is found by multiplying this 
number by the corresponding group multiplier, {r1, r2, ..., rG}, and rounding up to the next integer. 

You can specify a single value or a list. 

Single Value 
Enter a value for the base group subject count. 

List of Values 
A separate power analysis is calculated for each value of Ni in the list. 

Range 
Ceiling[Ni x ri] ≥ 1. 

N1, N2, …, NG (List) 
Enter a list of G subject counts, one for each group.  

Incomplete List 
If the number of items in the list is less than G, the missing subject counts are set equal to the last entry in the list. 

Range 
The items in the list must be positive. At least one item in the list must be greater than 1. 

Columns of Ni’s 
Enter one or more spreadsheet columns containing vertical lists of group subject counts. 

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values. 

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can 
obtain the spreadsheet by selecting "Tools", then "Input Spreadsheet", from the menus. 

On the spreadsheet, the group subject counts are entered going down. 

Examples (assuming G = 3) 
C1 C2 C3 
111 1 28 
115 20 68 
100 30 46 

Definition of a Single Column 
Each column gives one list. Each column results in a new scenario. The columns are not connected, but all should 
have exactly G rows. 

Each entry in the list is the subject count of that group. 

Incomplete List 
If the number of items in the list is less than G, the missing entries are set equal to the last entry in the list. 

Valid Entries 
All values should be positive integers. At least one value must be greater than one. 

Note 
The column names (C1, C2, ...) can be changed by right-clicking on them in the spreadsheet.  
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Group Allocation Input Type (when Solve For = Sample Size) 
Specify how you want to enter the information about how the subjects are allocated to each of the G groups. 

Options 

• Equal (N1 = N2 = ... = NG) 
All group subject counts are equal to Ni. The value of Ni will be found by conducting a search. 

• Enter group allocation pattern 
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be 
rescaled into proportions by dividing each item by the sum of all items. The individual group subject counts 
are found by multiplying these proportions by N (the total subject count) and rounding up. 

• Enter columns of allocation patterns 
Select one or more columns of the spreadsheet that each contain a group allocation pattern going down the 
column. Each column is analyzed separately. 

Group Allocation Pattern (r1, r2, ..., rG) 
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be 
rescaled into proportions of N by dividing each item by the sum of all items. The individual group subject counts 
are found by multiplying these proportions by N (the total subject count) and rounding up. 

For example, the pattern {1, 3, 4} will be rescaled to {0.125, 0.375, 0.5}. The group subject counts will be 
constrained to these proportions (within rounding) during the search for the subject count configuration that meets 
the power requirement. 

Incomplete List 
If the number of items in the list is less than G, the missing numbers are set equal to the last entry in the list. 

Range 
The items in the list must be positive. The resulting subject counts must be at least 1. 

Columns of Group Allocation Patterns 
Enter one or more spreadsheet columns containing vertical lists of group allocation patterns. 

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values. 

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can 
obtain the spreadsheet by selecting "Tools", then "Input Spreadsheet", from the menus. 

On the spreadsheet, the group allocation patterns are entered going down. 

Examples (assuming G = 3) 
C1 C2 C3 
1 1 3 
1 2 3 
3 2 1 

Definition of a Single Column 
Each column gives one allocation pattern. Each column results in a new scenario. The columns are not connected, 
but all should have exactly G rows. 

Incomplete List 
If the number of items in a list is less than G, the missing numbers are set equal to the last entry in the list before 
they are rescaled. 
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Valid Entries 
All values should be positive numbers. You can enter decimal values. 

Note 
The column names (C1, C2, ...) can be changed by right-clicking on them in the spreadsheet. 

Effect Size  

μi's Input Type 
Specify how you want to enter the G group means μ1, μ2, ..., μG assumed by the alternative hypothesis. The 
power is calculated for these values. 

Note that under the null hypothesis, these means are all equal. 

Options 

• μ1, μ2, ..., μG 
Specify the values of the group means. The SD of these values is proportional to the effect size that you 
want to detect. 

• μ1, μ2, ..., μG and Multipliers 
Specify the values of the group means as well as one or more multipliers for quickly generating sets of 
means. 

• Columns Containing Sets of μi's 
Select one or more columns of the spreadsheet that each contain a set of μi's going down the column. 
Each column is analyzed separately. 

• σm (SD of μi's) 
Enter one or more values of the standard deviation of the μi's. 

(The individual values of the μi's are not needed. Only their SD is used in the power calculations.) 

μ1, μ2, ..., μG 
Enter the values of the G group means under the alternative hypothesis. The effect size that the study will detect is 
a function of the differences among these values. 

The mean for a particular group is the average response of all subjects in that group.  

Range 
Each μi should be numeric and at least one of the values must be different from the rest. 

Example 
10 10 10 40 

Incomplete List 
If the number of items in a list is less than G, the missing numbers are set equal to the last entry. 
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K (Means Multiplier) 
Enter one or more values for K, the means multiplier. A separate power calculation is conducted for each value of 
K. In each analysis, all means (μi's) are multiplied by K. In this way, you can determine how sensitive the power 
values are to the magnitude of the means without the need to change them individually. 

For example, if the original means are ‘0 1 2’, setting this option to ‘1 2’ results in two sets of means used in 
separate analyses: ‘0 1 2’ in the first analysis and ‘0 2 4’ in the second analysis. 

Examples 

1 

0.5 1 1.5 

0.8 to 1.2 by 0.1 

Columns Containing Sets of μi’s 
Enter one or more spreadsheet columns containing vertical lists of μ1, μ2, ..., μG. 

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values. 

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can 
obtain the spreadsheet by selecting "Tools", then "Input Spreadsheet", from the menus. 

On the spreadsheet, the μi’s are entered going down. 

Examples (assuming G = 3) 
C1 C2 C3 
10 10 30 
10 20 30 
30 20 10 

Definition of a Single Column 
Each column gives one set of means. Each column results in a new scenario. The columns are not connected, but 
all should have exactly G rows. 

Incomplete List 
If the number of items in a list is less than G, the missing numbers are set equal to the last entry in the list. 

Valid Entries 
You can enter any numeric value. 

Note 
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet. 

σm (SD of μi's) 
Enter one or more values of σm, the standard deviation of the group means. This value approximates the average 
size of the differences among the means that is to be detected. By detected, we mean that if σm is this large, the 
null hypothesis of mean equality will likely be rejected. 

The value of σm is calculated using the formula shown earlier in this chapter. 

Since this is a standard deviation, it must be greater than zero. It is in the same scale as σ, the within group 
standard deviaton. 

A common measure of the effect size is σm/σ. 
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σ (Standard Deviation) 
This is σ, the standard deviation between subjects within a group. It represents the variability from subject to 
subject that occurs when the subjects are treated identically. It is assumed to be the same for all groups. This value 
is approximated in an analysis of variance table by the square root of the mean square error. 

Since they are positive square roots, the numbers must be strictly greater than zero. You can press the σ button to 
obtain further help on estimating the standard deviation. 

Note that if you are using this procedure to test a factor (such as an interaction) from a more complex design, the 
value of standard deviation is estimated by the square root of the mean square of the term that is used as the 
denominator in the F test.  

You can enter a single value such as ‘10’ or a series of values such as ‘10 20 30 40 50’ or ‘1 to 5 by 0.5’. 
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Example 1 – Finding power 
An experiment is being designed to compare the means of four groups using an F test with a significance level of 
either 0.01 or 0.05. Previous studies have shown that the standard deviation is 18. Treatment means of 40, 10, 10, 
and 10 represent clinically important treatment differences. To better understand the relationship between power 
and sample size, the researcher wants to compute the power for several group sample sizes between 2 and 14. The 
sample sizes will be equal across all groups.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alpha ....................................................... 0.01 0.05 
G (Number of Groups) ............................ 4 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
Ni (Subjects Per Group) ......................... 2 4 6 8 10 12 14 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 40 10 10 10 
σ (Standard Deviation) ........................... 18 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  4 
 
    SD    
 Total Subjects Group of    
 Sample Per Means Group Std Effect  
 Size Group Set Means Dev Size  
Power N Ni μi σm σ σm/σ Alpha 
0.0424 8 2 μi(1) 12.99 18.00 0.722 0.010 
0.2389 16 4 μi(1) 12.99 18.00 0.722 0.010 
0.5058 24 6 μi(1) 12.99 18.00 0.722 0.010 
0.7269 32 8 μi(1) 12.99 18.00 0.722 0.010 
0.8670 40 10 μi(1) 12.99 18.00 0.722 0.010 
0.9414 48 12 μi(1) 12.99 18.00 0.722 0.010 
0.9762 56 14 μi(1) 12.99 18.00 0.722 0.010 
0.1751 8 2 μi(1) 12.99 18.00 0.722 0.050 
0.5216 16 4 μi(1) 12.99 18.00 0.722 0.050 
0.7733 24 6 μi(1) 12.99 18.00 0.722 0.050 
0.9064 32 8 μi(1) 12.99 18.00 0.722 0.050 
0.9651 40 10 μi(1) 12.99 18.00 0.722 0.050 
0.9880 48 12 μi(1) 12.99 18.00 0.722 0.050 
0.9961 56 14 μi(1) 12.99 18.00 0.722 0.050 
 
Set(Set Number): Values 
μi(1): 40.00, 10.00, 10.00, 10.00 
 

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
One-Way Analysis of Variance F-Tests 

547-11 
 © NCSS, LLC. All Rights Reserved. 

 
References 
Desu, M. M. and Raghavarao, D. 1990. Sample Size Methodology. Academic Press. New York.  
Fleiss, Joseph L. 1986. The Design and Analysis of Clinical Experiments. John Wiley & Sons. New York.  
Kirk, Roger E. 1982. Experimental Design: Procedures for the Behavioral Sciences. Brooks/Cole. Pacific Grove, 
   California.  
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
Total Sample Size N is the total number of subjects in the study. 
Subjects Per Group Ni is the number of subjects per group. 
Group Means Set μi gives the name and number of the set containing the mean responses for each group. 
SD of Group Means σm is the population standard deviation of the group means. 
Std Dev σ is the common standard deviation of the responses within a group.  
Effect Size σm/σ is a measure of the effect size. It is the ratio of σm and σ. 
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal means when it is 
   true. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
In a one-way ANOVA study, a sample of 8 subjects, divided among 4 groups, achieves a power of 0.0424. This 
power assumes an F test is used with a significance level of 0.010. The group subject counts are 2, 2, 2, 2. The 
group means under the alternative hypothesis are 40.00, 10.00, 10.00, 10.00. The standard deviation of these 
means is 12.99. The common standard deviation of the responses is 18.00. The effect size is 0.722. 

 

This report shows the numeric results of this power study.  

Plots Section 
 

    
 

These plots give a visual presentation to the results in the Numeric Report. We can quickly see the impact on the 
power of increasing the sample size and the increase in the significance level. 
When you create one of these plots, it is important to use trial and error to find an appropriate range for the 
horizontal variable so that you have results with both low and high power. 
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Example 2 – Power after a study 
This example will cover the situation in which you are calculating the power of a one-way analysis of variance F 
test on data that have already been collected and analyzed. 

An experiment included a control group and two treatment groups. Each group had seven individuals. A single 
response was measured for each individual and recorded in the following table. 
 

Control T1 T2 
452 646 685 
674 547 658 
554 774 786 
447 465 536 
356 759 653 
654 665 669 
558 767 557 

 

When analyzed using the one-way analysis of variance procedure in NCSS, the following results were obtained.  
   
 Analysis of Variance Table  
   
 Source  Sum of Mean  Prob 
 Term DF Squares Square F-Ratio Level  
 A ( ... ) 2 75629.8 37814.9 3.28 0.061167 
 S(A) 18 207743.4 11541.3 
 Total (Adjusted) 20 283373.3 
 Total 21 
 
 Means Section 
    

Group Count Mean 
Control 7 527.8571 
T1 7 660.4286 
T2 7 649.1429 

 

The significance level (Prob Level) was 0.061—not enough for statistical significance. The researcher had hoped 
to show that the treatment groups had higher response levels than the control group. He could see that the group 
means followed this pattern since the mean for T1 was about 25% higher than the control mean and the mean for 
T2 was about 23% higher than the control mean. He decided to calculate the power of the experiment using these 
values of the means. (We do not recommend this approach because the power should be calculated for the 
minimum difference among the means that is of interest, not at the values of the sample means.) 
The data entry for this problem is simple. The only entry that is not straight forward is finding an appropriate 
value for the standard deviation. Since the standard deviation is estimated by the square root of the mean square 
error, it is calculated as 11541.3 = 107 4304. . 
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Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 3 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
Ni (Subjects Per Group) ......................... 7 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 527.8571 660.4286 649.1429 
σ (Standard Deviation) ........................... 107.4304 
 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  3 
 
    SD    
 Total Subjects Group of    
 Sample Per Means Group Std Effect  
 Size Group Set Means Dev Size  
Power N Ni μi σm σ σm/σ Alpha 
0.5479 21 7 μi(1) 60.01 107.43 0.559 0.050 
 

The power is only 0.55. That is, there was only a 55% chance of rejecting a false null hypothesis. It is important 
to understand this power statement is conditional, so we will state it in detail. Given that the population means are 
equal to the sample means (that σm is 60.01) and the population standard deviation is equal to 107.43, the 
probability of rejecting the false null hypothesis is 0.55. If the population means are different from the sample 
means (which they must be), the power is different. 
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Example 3 – Finding the sample size necessary to reject 
Continuing with the last example, we will determine how large the sample size would need to have been for alpha 
= 0.05 and power = 0.80. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 3 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 527.8571 660.4286 649.1429 
σ (Standard Deviation) ........................... 107.4304 
 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  3 
 
    SD    
 Total Group Group of    
 Sample Alloc Means Group Std Effect  
 Size Set Set Means Dev Size  
Power N ri Set μi σm σ σm/σ Alpha 
0.8251 36 ri(1) μi(1) 60.01 107.43 0.559 0.050 
 
Set(Set Number): Values 
ri(1): 0.333, 0.333, 0.333 
μi(1): 527.86, 660.43, 649.14 

 
The required sample size is 36 which is 12 per group. 
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Example 4 – Power using unequal sample sizes 
Continuing with the last example, consider the impact of allowing the group sample sizes to be unequal. Since the 
control group is being compared to two treatment groups, the mean of the control group is assumed to be different 
from those of the treatment groups. In this situation, adding extra subjects to the control group can increase power 
because the value of σm is increased.  

In this example, we will evaluate to designs, both of which have a total of 33 subjects. In the first design, all three 
groups are assigned 11 subjects. In the second design, the sample size of the control group is set to 15 and to 9 in 
each of the treatment groups.  

In order to carry out this comparison, we will enter the two sets of sample sizes in the spreadsheet. The resulting 
spreadsheet will appear as 

C1 C2 
11 15 
11 9 
11 9 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 4 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 3 
Group Allocation Input Type ................... Enter columns of Ni's 
Columns of Ni's ....................................... C1 C2 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 527.8571 660.4286 649.1429 
σ (Standard Deviation) ........................... 107.4304 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  3 
 
  Group  SD    
 Total Sample Group of    
 Sample Size Means Group Std Effect  
 Size Set Set Means Dev Size  
Power N Ni Set μi σm σ σm/σ Alpha 
0.7851 33 C1(1) μi(1) 60.01 107.43 0.559 0.050 
0.8297 33 C2(2) μi(1) 63.34 107.43 0.590 0.050 
 
Set(Set Number): Values 
C1(1): 11, 11, 11 
C2(2): 15, 9, 9 
μi(1): 527.86, 660.43, 649.14 
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The power of 0.8297 achieved with the second design is slightly higher than the power of 0.7851 that was 
achieved by the first design. As was mentioned above, this occurs because the value of σm was increased with the 
second design. 

Example 5 – Minimum detectable difference 
It may be useful to determine the minimum detectable difference among the means that can be found at the 
experimental conditions. This amounts to finding σm. 

Continuing with the previous example, find σm for a range of sample sizes from 15 to 240 when alpha is 0.05 and 
power is 0.80 or 0.90. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 5 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Effect Size 
Power ...................................................... 0.8 0.9 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 3 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
Ni (Subjects Per Group) ......................... 5 10 15 20 40 60 80 
σ (Standard Deviation) ........................... 107.4304 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results and Plots 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  3 
 
   SD    
 Total Subjects of    
 Sample Per Group Std Effect  
 Size Group Means Dev Size  
Power N Ni σm σ σm/σ Alpha 
0.8000 15 5 98.08 107.43 0.913 0.050 
0.8000 30 10 64.42 107.43 0.600 0.050 
0.8000 45 15 51.54 107.43 0.480 0.050 
0.8000 60 20 44.21 107.43 0.411 0.050 
0.8000 120 40 30.83 107.43 0.287 0.050 
0.8000 180 60 25.07 107.43 0.233 0.050 
0.8000 240 80 21.66 107.43 0.202 0.050 
0.9000 15 5 112.62 107.43 1.048 0.050 
0.9000 30 10 73.86 107.43 0.688 0.050 
0.9000 45 15 59.07 107.43 0.550 0.050 
0.9000 60 20 50.67 107.43 0.472 0.050 
0.9000 120 40 35.34 107.43 0.329 0.050 
0.9000 180 60 28.73 107.43 0.267 0.050 
0.9000 240 80 24.82 107.43 0.231 0.050 
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These plots show the relationships between power, sample size, and effect size. Several conclusions are possible, 
but the most impressive is the sharp elbow in the curve that occurs near Ni = 10 when σm is about 60. 

How do you to interpret a σm of 60? One way is to find a set of means that have a standard deviation of 60. To do 
this, press the σ button in the lower right corner of the panel to load the Standard Deviation Estimator module. 
Under the Data tab, enter the three values 0, 0, and 64 as a starting point. These values have a standard deviation 
of 30. Doubling the 64 to 128 results in an SD of 60. The difference between the minimum and the maximum of 
these three values is 128. Hence the minimum detectable difference is about 128 for a σm of 60 when Ni is 10 and 
the power is 80%. 
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Example 6 – Validation using Fleiss (1986) 
Fleiss (1986) page 374 presents an example of determining a sample size in an experiment with 4 equal sized 
groups; means of 9.775, 12, 12, and 14.225; standard deviation of 3; alpha of 0.05, and beta of 0.20. He finds a 
sample size of 11 per group which amounts to a total sample size of 44.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 6 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power ...................................................... 0.8 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 4 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 9.775 12 12 14.225 
σ (Standard Deviation) ........................... 3 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  4 
    SD    
 Total Group Group of    
 Sample Alloc Means Group Std Effect  
 Size Set Set Means Dev Size  
Power N ri Set μi σm σ σm/σ Alpha 
0.8027 44 ri(1) μi(1) 1.57 3.00 0.524 0.050 
 
Set(Set Number): Values 
ri(1): 0.250, 0. 250, 0. 250, 0.250 
μi(1): 9.78, 12.00, 12.00, 14.23 
 
 

PASS also found N = 44. Note that Fleiss used calculations based on a normal approximation, but PASS uses 
exact calculations based on the non-central F distribution. 
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Example 7 – Validation using Desu (1990) 
Desu (1990) page 48 presents an example of determining a sample size in an experiment with 3 groups; means of 
0, -0.2553, and 0.2553; standard deviation of 1; alpha of 0.05, and beta of 0.10. He finds a sample size of 99 per 
group for a total of 297. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure. You may then make the appropriate entries as listed below, or open Example 7 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power ...................................................... 0.9 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 3 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 0 -.2553 0.2553 
σ (Standard Deviation) ........................... 1 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  3 
    SD    
 Total Group Group of    
 Sample Alloc Means Group Std Effect  
 Size Set Set Means Dev Size  
Power N ri Set μi σm σ σm/σ Alpha 
0.9028 297 ri(1) μi(1) 0.21 1.00 0.208 0.050 
 
Set(Set Number): Values 
ri(1): 0.333, 0.333, 0.333 
μi(1): 0.00, -0.26, 0.26 
 

PASS also found N = 297. 
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Example 8 – Validation using Kirk (1982) 
Kirk (1982) pages 140-144 presents an example of determining a sample size in an experiment with 4 groups; 
means of 2.75, 3.50, 6.25, and 9.0; standard deviation of 1.20995; alpha of 0.05, and beta of 0.05. He finds a 
sample size of 3 per group for a total sample size of 12. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure. You may then make the appropriate entries as listed below, or open Example 8 by 
going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power ...................................................... 0.95 
Alpha ....................................................... 0.05 
G (Number of Groups) ............................ 4 
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG) 
μi's Input Type ........................................ μ1, μ2, ..., μG 
μ1, μ2, ..., μG .......................................... 2.75 3.5 6.25 9 
σ (Standard Deviation) ........................... 1.20995 
 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results ──────────────────────────────────────────────────────────── 
Number of Groups:  3 
    SD    
 Total Group Group of    
 Sample Alloc Means Group Std Effect  
 Size Set Set Means Dev Size  
Power N ri Set μi σm σ σm/σ Alpha 
0.9977 12 ri(1) μi(1) 2.47 1.21 2.038 0.050 
 
Set(Set Number): Values 
ri(1): 0.250, 0.250, 0.250, 0.250 
μi(1): 2.75, 3.50, 6.25, 9.00 

 

PASS also found N = 12. 
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